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The Company 
 

We are an established world force in the design and manufacture of power electronics and power 

protection equipment. 

As a part of ABB, a world leader in electrical technology, we offer customers application expertise, service 

and support worldwide. We are committed to teamwork, high quality manufacturing, advanced technology 

and unrivalled service and support. 

The quality, accuracy and performance ABB’s products result from over 100 years of experience, 

combined with a continuous program of innovative design and development to incorporate the latest 

technology. 

— 

Quality control 

To ensure that we meet our responsibilities and obligations to our customers, our people, our partners, 

our suppliers and to our shareholders, we are committed to deliver on-time and on-quality products, 

systems and services that meet or exceed our customers’ expectations. 

— 

For more information 

Further publications for the PowerView monitoring System and accessories are available for free download 

from http://new.abb.com/ups/power-distribution or by scanning the QR code below. 
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Contacting ABB for support 
 

To contact ABB for information or repair service in the United States, call 1 800 292 3739. ABB offers a 

complete range of start-up services, repair services, preventive maintenance plans and service contracts. 

For repair or maintenance service outside the 48 contiguous United States, contact ABB, if available in 

your area. 

Please provide the following information for customer service when you contact the ABB service center: 

 

Equipment   

Part number  

Serial number  

Voltage rating  

Current rating  

Purchase date  

Installation date  

Location  

 

To get important information on all equipment warranties, please contact the ABB service center or 

request service follow-up or by scanning the QR code below. 
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Safety notices 
 

PowerView monitoring systems are typically installed in a high-energy distribution product such as a 

Power Distribution Unit (PDU) or Remote Power Panel (RPP).  Refer to your distribution product manual for 

further safety information. 

The following safety instructions must be observed when working with the device.  Refer to the nameplate 

of the distribution product for the specific model designation and operating parameters.  External input 

over-current protection is to be supplied by the user in accordance with nameplate ratings for applications 

where the distribution product has no main breaker. 

These symbols may appear on your distribution product or on labels inside the distribution product.  Most 

international safety agents accept them.  Everyone in your organization who works with your system 

should understand the meaning of these symbols: 

Safety notice  

   

   

CAUTION – Refer to manual 

Stop and refer to the operator manual for more information. 

 

WARNING – Risk of electric shock 

There is a risk of electric shock present, and you should observe associated 

warnings.  The Distribution Product contains high voltages. 

 

 

— 

Safety precautions 
 

The distribution products where PowerView is typically installed contain hazardous voltages which are 

present regardless of the mode of operation.  Before making any connection(s) to the distribution product, 

ensure that any/all power sources are de-energized and locked out. 

As lethal voltages are present within the distribution product during all modes of operation, maintenance 

shall only be performed by authorized service personnel. 

Refer to your distribution product manual for further safety precautions. 

ABB neither recommends nor knowingly sells this product for use with life support applications or other 

FDA designed critical applications. 

All wiring should be performed by qualified electricians and in the accordance with local and national 

electrical safety codes.  Before placing the unit into service, a thorough inspection and supervised start-up 

should be performed by a qualified service technician. 
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Safety considerations 
 

PowerView monitoring systems are typically installed in power protection equipment such as a Power 

Distribution Unit (PDU) or Remote Power Panel (RPP).  Refer to your power protection product user’s 

manual for further safety considerations. 

The PowerView monitoring system is designed for commercial market applications, and typically is 

installed within complex power systems that should be handled with appropriate care, following these 

guidelines: 

− Keep surroundings clean and free from excess moisture. 

− Do not operate the PowerView monitoring system close to gas or electric heat sources. 

− The system is not intended for outdoor use. 

− The operating environment should be maintained within the parameters stated in the manual. 

− Keep the cabinet doors closed and locked to ensure proper cooling airflow and to protect personnel 

from dangerous voltages inside the unit. 

Safety consideration  

 CAUTION 

Only authorized service personnel should perform maintenance on or service the 

PowerView system. 

 

If service or routine maintenance is required: 

− Ensure all power is disconnected before performing maintenance. 

− Ensure the area around the PowerView monitoring system is clean and uncluttered. 

− Observe all DANGER, CAUTION and WARNING notices affixed to the inside and outside of the 

PowerView monitoring systems and the distribution product in which it is typically installed. 
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1  General 

1.1 Using this manual 

This manual is provided to aid the user in the installation, operation, and maintenance of the PowerView 

monitoring system, manufactured by ABB.  Read and understand the procedures described to ensure 

trouble-free installation and operation. 

Read through each procedure before beginning the procedure.  Perform only those procedures that apply 

to the PowerView monitoring system being installed or operated. 

1.1.1 List of symbols  

Symbols  

 

DANGER – Risk of electric shock 

This symbol in conjunction with the signal word "DANGER" indicates an imminent 

electrical hazard.  Observe the warning associated with the risk of electric shock 

symbol. 

 

WARNING – Bodily injury 

This symbol in conjunction with the signal word "WARNING" indicates a 

potentially dangerous situation.  Failure to observe the related safety note may 

cause personnel injury or death or equipment damages. 

   

   

CAUTION – Refer to manual 

This symbol in conjunction with the signal word "CAUTION” indicates that before 

proceeding, the user should refer to the appropriate section of this manual. 

 

IMPORTANT – NOTE 

This symbol indicates operator tips, particularly useful or important information 

for the use of the product.  This symbol and wording does not indicate a 

dangerous situation. 

 
The universal symbol for Recycle. 

 

This symbol indicates that you should not discard waste electrical or 

electronic equipment (WEEE) in the trash.  

For proper disposal, contact your local recycling/reuse or hazardous waste 

center. 
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1.2 Electrical safety precautions 

The PowerView monitoring system is typically installed in, or is connected to, power protection equipment 

such as a Power Distribution Unit (PDU) or Remote Power Panel (RPP), which can be connected to one (1) 

or more single (1) or three (3) phase power sources. Refer to the monitored equipment’s nameplate for 

the specific model designation, operating voltage, and input power configuration, and to its operating 

manual for additional safety precautions. 

Warning  

 WARNING 

As lethal voltages exist within all operating modes of the distribution product, 

maintenance can only be performed by qualified and authorized trained service 

personnel.  

ABB neither recommends nor knowingly sells this product for use with life 

support applications or other FDA designated critical applications. 

All wiring should be performed by qualified electricians and in accordance with 

local and national electrical safety codes.  Before placing the unit into service, a 

thorough inspection and supervised start-up should be performed by a qualified 

technician. 

 

Warning  

 
WARNING 

To provide sufficient isolation protection when working upstream of the 

distribution product, open the respective source feeder breakers contained within 

the distribution product.  Prescribing to this maintenance method reduces the 

risk of electric shock due to backfeed. 

 

Danger  

 

DANGER – Risk of electric shock 

Current transformers (CT’s) with an open secondary can generate a significantly 

high voltage across its terminals, which poses a shock hazard to personnel and 

can damage equipment.  

 

Prior to servicing the PowerView, ensure all CT’s secondary circuits have been 

shorted, primary circuits have been disconnected and LOTO, or that functioning 

open circuit protection is installed. 
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1.3 Cybersecurity 

1.3.1 Disclaimer 

This product is designed to be connected to and to communicate information and data via a network 

interface. It is the Customer's sole responsibility to provide and continuously ensure a secure connection 

between the product and Customer network or any other network (as the case may be). The customer 

shall establish and maintain any appropriate measures (such as but not limited to the installation of 

firewalls, application of authentication measures, encryption of data, installation of anti-virus programs, 

etc.) to protect the product, the network, its system and the interface against any kind of security 

breaches, unauthorized access, interference, intrusion, leakage and/or theft of data or information. ABB 

Ltd and its affiliates are not liable for damages and/or losses related to such security breaches, any 

unauthorized access, interference, intrusion, leakage and/or theft of data or information. 

We recommend connecting the system in private network, if not the case additional hardware that provide 

increased security controls/measures such as firewalls should be implemented 

1.3.2 Ports used by this product 

Table 1-1:  TCP/UDP service ports used by this product 

Port Service Purpose 

22/tcp SSH Valid for SSH 

502/tcp Modbus/TCP Valid for Modbus TCP 

25/tcp Email Valid of Email 

110/tcp Email Valid of Email 

143/tcp Email Valid of Email 

465/tcp Email Valid of Email 

587/tcp Email Valid of Email 

993/tcp Email Valid of Email 

995/tcp Email Valid of Email 

69/udp TFTP Valid for Software Upgrade 

123/udp NTP Valid for Network Time Products 
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1.4 Equipment description overview 

1.4.1 Application overview 

PowerView monitoring system can be used for communicating valuable information to your central 

management system, or to a local or remote display. We recommend connecting the system in private 

network, if not the case additional hardware that provide increased security controls/measures such as 

firewalls should be implemented.  PowerView actively monitors the load current of each of your power 

distribution circuits and reports this information to you for cost allocation or load protection management. 

PowerView can be configured to monitor the following, depending on the system being monitored: 

1.4.1.1 Branch Circuit Management (BCM) 

PowerView can be configured to monitor up to 252 branch circuits on up to 6 power distribution 

panelboards which are powered by 1 to 6 sources of three-phase voltages.  The source voltages for 

panelboards are user configurable, i.e., the user can configure any source to any panelboard.  PowerView 

monitors the RMS branch currents and voltages. Based on the above parameters, it calculates the power 

quality parameters like power, energy, load, power factor, MD (Maximum Demand), etc. It also monitors 

panel level currents, voltages and other power quality parameters. PowerView generates warnings/alarms 

for different power quality parameters based on the thresholds and delays configured by the user. 

1.4.1.2 Sub-feed Circuit Management (SFCM) 

PowerView can be configured to monitor sub-feeds and/or main feeds in a Power Distribution System, up 

to 67 (each 3 phase) without neutrals or 60 with neutral, which are powered by 1 to 6 sources of three-

phase voltages.  PowerView monitors the sub-feed or main feed RMS phase currents and voltages.  Based 

on the above parameters, it calculates the power quality parameters such as power, energy, load, power 

factor, and MD (Maximum Power Demand).  PowerView generates warnings/alarms for different power 

quality parameters based on the thresholds and delays configured by the user.   

1.4.1.3 Transformer monitoring 

PowerView monitors voltage and current on all three phases of a power distribution transformer.  

Warnings and alarms notify operators when monitored current, voltage or power approaches user set 

limits.  PowerView generates warnings/alarms for different power quality parameters based on the 

thresholds and delays configured by the user. 

1.4.1.4 Discrete Input monitoring 

PowerView can be configured to monitor input sensors placed in the unit.  Circuit breakers are the most 

commonly monitored input.  PowerView can monitor up to 150 discrete input sensors, depending on cards 

configured.   

1.4.1.5 Thermocouple monitoring 

PowerView can be configured to monitor thermocouple placed in the unit.  PowerView will support Type J, 

Type E, Type K or Type T thermocouples.  PowerView can monitor up to 90 thermal sensors, depending on 

cards configured.  Thresholds can be set to provide alerts and warnings as sensed temperatures pass 

these thresholds.  
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2 Installation 

2.1 Installation site 

2.1.1 Operating environment 

The PowerView is designed for indoor applications only and must be protected from excessive moisture or 

corrosive environments.  The PowerView is not intended for use in the presence of explosive gases. 

This unit complies with the limits for a Class A digital device in accordance with Part 15, Subpart J of the 

FCC rules; therefore, it is suitable for use in a commercial environment.  If not used in accordance with its 

design intent, and in accordance with the instructions contained within this manual, PDU may cause 

interference with radio frequency communications. 

Required operating environment conditions can be found in Section 8.4. 

2.1.2 Positioning 

PowerView is typically located inside the cabinet of a distribution product such as a PDU or RPP.  It is 

either factory installed or installed in the field by an ABB certified technician. 

Refer to the distribution product manuals, and associated outline drawings for the exact location of 

PowerView inside your unit’s cabinet. 

 

Caution  

 

− Make sure all cabinet ventilation openings are clear of obstructions. 

 

2.2 Checking the supplied parts 

2.2.1 Inspection 

2.2.1.1 Shipping and delivery 

Every ABB Power Protection product is fully tested and has passed our thorough quality control inspection 

prior to delivery.  Once the product is tested and quality control inspected, the unit is then carefully 

packaged for delivery. 

PowerView is typically located inside the cabinet of a distribution product.  Refer to the distribution 

product manuals, and associated outline drawings for the exact location of PowerView inside your unit’s 

cabinet, and for inspection instructions before and after unpacking the unit. 
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2.2.2 Meter overview 

PowerView consists of three main components: 

• A sheet metal enclosure surrounding a Backplane Distribution Board (BDB) with either 2 or 6 slots 

• A Main Control Board (MCB), with USB and RJ-45 connectors for communicating with other 

modules inside the distribution product and with service tools. 

• Daughter cards with various metering and monitoring functions which can be mixed according to 

the needs of the unit to be monitored.   Daughter cards can be added to an existing PowerView for 

new capabilities.  Installation and configuration must be completed by ABB Service personnel. 

o Analog Conditioning Boards (ACB) for monitoring branches and sub-feeds. Each board has 

two sets of connectors: 

▪ Four connectors with 22 positions for connecting to branch or sub-feed current 

transformers (CT). 

▪ One connector with 8 positions for connecting to panel main or sub-feed CT’s. 

▪ Four 2 pin connectors for connecting to voltage phases and neutral. 

o Primary-Secondary Board (PSB) for monitoring the PDU transformer.  Each board has two 

sets of connectors: 

▪ Two connectors with 22 positions for connecting to current transformers (CT). 

▪ Eight 2 pin connectors for connecting to voltage phases and neutral. 

o Discrete Input Board (DIB) for monitoring input status of components like breakers or 

doors.  Each board has seven Phoenix-style connectors with screw clamps for connecting to 

input sensor wires.  

o Thermocouple Input Board (TIB) for monitoring thermocouples placed throughout the unit.  

Each board has four Phoenix-style connectors with screw clamps for connecting to 

thermocouple sensor wires. 

o Blind cover, for open slots 

A sample PowerView Assembly is shown in Figure 2-1 and Figure 2-2. 
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Figure 2-1:  PowerView assembly front view 
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Figure 2-2:  PowerView assembly bottom view 
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3 Startup 

3.1 Power up 

PowerView will typically power up with the distribution product.  LED’s LD11 and LD12 on the MCB will 

indicate that the system is powering up by being continuously lighted.  Refer to the distribution product 

manuals for power up procedures for the unit.  Follow all safety warnings and procedures. 

LED’s LD1 and LD2 indicate communication and will blink when communications are functionating 

normally. 

3.1.1 Power supply requirements 

Power supplies for PowerView need to meet the following requirements: 

• 12-28 VDC output voltage 

• 4A output current 

• 0°C to 40°C operating temperature  

• UL 60950 listed, SELV or Class 2 

The PowerView power supply connection is located as shown in Figure 2-2, and is TE Connectivity part 

number 640389-3 or equivalent.  
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4 Metering and monitoring 

All referenced voltages and currents are based on the standard 480 -208/120V units.  See as built 

documents and/or unit nameplate for unit specific voltages.   

4.1 Overview 

The PowerView monitoring system will be used to monitor various voltages & currents in a power 

distribution panel or remote power panel.  It will also compute various other parameters such as power, 

energy, demand, frequency, power factor, etc.  Specific parameters for transformers, branches and sub-

feeds are shown in Section 4.2.1.  

4.2 Product description 

The Metering module will acquire the voltage & current signals from current transformers through an 

Analog Conditioning board or Primary/Secondary Board.  It will calculate energy and power quality 

parameters.  These parameters are passed to the display board/PC for display and data logging.  It will 

also receive control/command/system parameter data from display board or a third-party display module.  

Meters can be configured in groups to improve monitoring efficiency.  PowerView has capacity for up to 50 

custom groups.   

4.2.1 Monitored Parameters 

4.2.1.1 PowerView Branch Circuit Monitoring Parameters 

PowerView BCM shall provide the capability of measuring individual currents for up to 252 branch circuits 

residing in up to six 42 position panel boards or three 84 position panel boards.  Parameters include: 

• Real time current, peak current (resettable), minimum current (resettable) for each branch circuit  

• Panel board phase current 

• Voltage, power, energy, power factor and THD (current) for each branch circuit 

• Voltage, power, energy, power factor and THD (current) at the panel board level 

• User configurable warning and alarm thresholds for each circuit 

• User configurable warning and alarm statuses for each circuit 

• PC-based set up software capable of global or individual circuit setup 

4.2.1.2 PowerView Sub-feed Circuit Management Parameters 

PowerView SFCM shall provide the capability of providing phase current, metering at the sub-feed circuit 

level.  Parameters include: 

• Real time current, peak current (resettable), minimum current (resettable) for each sub-feed 

circuit 

• Voltage, power, energy, power factor and THD (current) 

• User configurable warning and alarm thresholds for each sub-feed circuit 

• User configurable warning and alarm statuses for each sub-feed circuit 

4.2.1.3 PowerView Main-feed Circuit Monitoring Parameters 

PowerView MFCM shall provide the capability of providing phase current, metering at the panel board main 

or source level with the following functionality: 

▪ Real time current, peak current (resettable), minimum current (resettable) for each main feed 

circuit 

▪ Voltage, power, energy, power factor and THD (current) for panel board main or source 

▪ User configurable warning and alarm thresholds for each main feed circuit 

▪ User configurable warning and alarm statuses for each main feed circuit 
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4.2.2 Current measurement 

For accurate current measurements in the mission critical power chain, the PowerView uses precisely 

specified Current Transformers (CT’s), which are installed at each monitored location.  

The CT’s used with the PowerView have a protective resistor installed across the secondary terminals. This 

resistor will limit the voltage across the CT’s terminals to less than 50Vrms, in the event of an open 

secondary, under otherwise normal operating conditions and currents. 

4.2.2.1 Branch circuit CT requirements 

For the measurement of branch circuits rated 60A or less installed in standard lighting panelboards, ABB 

Power Protection can provide compact CT strip assemblies. These CT strips are designed to provide an 

efficient means of measuring current in each branch circuit, without taking up significant wire gutter space 

or complicating the branch circuit wire installation.  

Each CT strip is supplied with the appropriate # of fully encapsulated, solid-core CT’s, a steel mounting 

bracket, and a complete wiring harness, with field accessible terminations (See Figure 4-1 for a typical CT 

strip). The CT strip assemblies are then mounted near the monitored panelboard, with the CT’s openings 

aligned with the terminals of each branch circuit breaker (See Figure 4-2 for a typical installation).  

 

Figure 4-1:  Typical CT strip 
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Figure 4-2:  Typical CT strip installation 

 

 

To accommodate the wide variety of lighting panelboards and branch circuit breaker styles available 

today, ABB Power Protection has the availability to offer CT strips with the following features: 

 

Table 4-1:  CT strip features 
 

Number of circuits per strip 21, 42 

Branch circuit pitch 0.71” ABB Proline, SmissLine 

0.75” Schneider NQ 

1.00” ABB-EPIS (GE) AQ/AE panels, Schneider NF, Bussman Quick 

Spec, Eaton/Cutler Hammer 

Mounting orientation Right-handed, Left-handed 

CT rating 60A:0.1A 

Maximum wire O.D. 0.275” 
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In addition to the options shown above, ABB Power Protection can provide 100A rated branch circuit CT’s 

for larger circuits and wire O.D.’s, and wire-mounted split-core CT’s for retrofit applications. Please contact 

ABB Power Protection for further information. 

The PowerView software supports the following two panelboard configurations: 

• The standard panelboard 

• The column-width panelboard 

The PowerView is configured for either of these configurations by the value set in the Modbus 

configuration.  See Section 4.2.3 for detailed information on Modbus configuration. 

 

4.2.2.2 Sub-feed or PDU CT requirements 

CT rating depends on whether the circuit is monitored with a PSB or an ACB.  See Table 4-2 for required 

current rating. 

Table 4-2:  Current Transformer Rating 

 PSB ACB 

Current Transformer Rating 5A secondary 0.1 A secondary 

 

4.2.3 Thermal measurement 

PowerView will acquire the signals from thermocouples placed throughout a PDU or RPP when a 

Thermocouple Input Board (TIB) is installed. Multiple TIB’s can be installed in PowerView.    Each TIB can 

accept up to 15 thermocouple inputs.  

4.2.3.1 Thermocouple requirements 

Thermocouples Type J, Type E, Type K or Type T are compatible for use with PowerView.  
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5 Modbus connectivity 

The PowerView acts as a Modbus slave, and can be accessed by the Modbus master using either Modbus 

RTU (via RS-485) or Modbus TCP through customer connection on the User Interface Modbus port.  See 

your system manual for the exact location of this interface.  The default PowerView slave ID=1 for 

identification by the master.  The default Modbus RTU settings are as follows.   

Baud rate: 19200 

Parity:  None 

Stop bits: 1 

5.1 Modbus map overview 

The Modbus map contains four different maps, which are assigned register ranges 

• MCB System map, Modbus registers from 1 - 1000 

• System map, Modbus registers from 1000 - 2000 

• Single-phase map, Modbus registers from 2001-39800 

• Three-phase map, Modbus registers from 40001-63450 

• Input Map, Modbus registers from 63451-65535 

Each map is described in a following section, and register definitions are provided in each section. 

Access types are either R = Read Only, or RW = Read/Write. 
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5.2 MCB System map  

The MCB system configuration map will contain the information related to the PowerView system 

configuration, including information on how many meters are present, type of each meter and meter 

status.  Modbus IDs from 1 to 1000 are allocated for the MCB system map. 

Table 5-1:  MCB System map values 

Reg. 
No. 

Description Format Scale Min Max Default 
Access 
Type 

Note 

1  Device ID         int16 1 1 20 1 R   

2  Uart Baud Rate Options  int16 1 1 5 5 R   

3  Major_Minor Version         int16 1 N/A N/A N/A R   

4  Patch Version         int16 1 N/A N/A N/A R   

5  Total no of meters  int16 1 N/A N/A N/A R   

6  System Alarm  int16 1 N/A N/A N/A R   

7  System Slot status int16 1 1 511 7 RW   

11  System Command int16 1 0 65535 0 RW See Table 5-2  

17 System Slot12 information int16 1 N/A N/A N/A R   

18 System Slot34 information int16 1 N/A N/A N/A R   

19 System Slot56 information int16 1 N/A N/A N/A R   

20 System Slot1 SW Version int16 1 N/A N/A N/A R   

21 System Slot2 SW Version int16 1 N/A N/A N/A R   

22 System Slot3 SW Version int16 1 N/A N/A N/A R   

23 System Slot4 SW Version int16 1 N/A N/A N/A R   

24 System Slot5 SW Version int16 1 N/A N/A N/A R   

25 System Slot6 SW Version int16 1 N/A N/A N/A R   

                  

51  Global panel no   int16 1 1 6 1 RW   

52 
 Global Over Current Alarm Set 
Limit  

int16 1 60 150 80 RW   

53 
 Global Over Current Alarm 
Hysteresis Limit 

int16 1 1 20 5 RW   

54 
 Global Over Current Alarm Set 
Delay 

int16 100 0.1 100 10 RW   

55 
 Global Over Current Alarm 
Reset Delay  

int16 100 0.1 100 10 RW   

56 
 Global Over Current Warning 
Set Limit 

int16 1 50 145 70 RW   

57 
 Global Over Current Warning 
Hysteresis Limit 

int16 1 1 20 5 RW   

58 
 Global Over Current Warning 
Set Delay 

int16 100 0.1 100 10 RW   

59 
 Global Over Current Warning 
Reset Delay 

int16 100 0.1 100 10 RW   

60 
 Global Under Current Alarm Set 
Limit  

int16 1 0 99 1 RW   

61 
 Global Under Current Alarm 
Hysteresis Limit 

int16 1 1 20 1 RW   

62 
 Global Under Current Alarm Set 
Delay 

int16 100 0.1 100 10 RW   

63 
 Global Under Current Alarm 
Reset Delay  

int16 100 0.1 100 10 RW   
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Table 5-2:  System Command register 

Bits Description 

0 Writing back default user configurations 

1 Resetting the alarm and warnings 

2 Resetting the min max values 

6 Command to backup calibration data 

 

5.3 General Settings map 

The General Settings map updates overall system status and transformer temperature status, UIB data 

and date and time.  Modbus IDs in the range from 1000 to 2000 are allocated for the General Settings 

map. 

5.3.1 Date and Time registers  

The 'Date and Time' Modbus registers are shown below in Table 5-3.  These registers are accessed using 

Function Codes 03 (Read Holding Registers) and 16 (Preset Multiple Registers).   

Table 5-3:  Modbus registers - Date and time 

Reg. No. Description Format Scale Min Max Default Type 

1411 Month (1-12) int16 1 1 12 N/A RW 

1412 Day (1-31) int16 1 1 31 N/A RW 

1413 Year (1970-2030) int16 1 1970 2030 N/A RW 

1414 Hours (0-23) int16 1 0 23 N/A RW 

1415 Minutes (0-59) int16 1 0 59 N/A RW 

1416 Seconds (0-59) int16 1 0 59 N/A RW 

1417 Milliseconds (0-999) int16 1 0 999 N/A RW 
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5.3.2 System Status registers 

The 'System Status' Modbus registers are shown below in Table 5-4.  These registers are accessed using 

Function Code 03 (Read Holding Registers). 

Table 5-4:  Modbus registers - System status 

Reg. No. Description Format Scale Min Max Default Type 

1001 

System Status 

int16 1 N/A N/A N/A R 
Bit 0: (Set = Summary Alarm) 

Bit 2: (Set = Unacknowledged 

Events) 

1002 

Outputs on UIB Port 

int16 1 N/A N/A N/A R 
Bit 0: (Set = Summary Alarm) 

Bit 1: (Set = Unacknowledged 

Events) 

1003 

Inputs on UIB Port 

Flag 1 N/A N/A N/A R 

Bit 0: (Set = PDU Transformer 

Excess Temperature) 

Bit 1: (Set = PDU Transformer 

Over Temperature) 

Bit 2: (Set = TVSS Fault) 

Bit 3: (Set = EPO [Local or 

Remote]) 

Bit 4: (Set = Circuit Breaker No. 

1: Open) 

Bit 5: (Set = Circuit Breaker No. 

2: Open) * 

Bit 6: (Set = Circuit Breaker No. 

3: Open) * 

Bit 7: (Set = Circuit Breaker No. 

4: Open) * 

1004 Display Board Temperature (°C) int16 1 N/A N/A N/A R 

1005 

PDU Transformer Excess 

Temperature int16 1 N/A N/A N/A R 

(0 = Normal; 1 = Warning) 

1006 

PDU Transformer Over 

Temperature int16 1 N/A N/A N/A R 

(0 = Normal; 2 = Alarm) 

* Optional 
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5.4 Single-phase map 

The Single-phase map contains the information of each single-phase meter. It contains user configuration, 

factory configuration, metering data and monitoring data for all single-phase meters.  

PowerView has capacity for up to 252 single-phase meters.  The Single-phase map starts from 2000. 

Modbus ID offset for each single-phase meter is 150, so that all registers assigned to the meter are 

assigned within that group of 150.  Each meter will start at a register id 150 higher than the previous 

meter’s starting register ID, as noted in Figure 5-1. 

Table 5-5 includes customer accessible registers, only. 

Figure 5-1:  Single-phase map offsets 

 

 

Table 5-5:  Single-phase Modbus register (Meter Index = 1) 

Reg 
No. 

Description Format Scale Min Max Default Unit  Notes 

2001 Meter rating int16 1 10 4000 200 A R  

2002  Voltage Rating         int16 1 120 600 120 V R   

2003  Frequency Rating         int16 1 50 60 60 Hz R   

2004  Meter Info ID         int16 1 0 65535 0 N/A R   

2007  CT Primary Scale  int16 10 0.1 6500 2500 Turns R   

2008  CT Secondary Scale  int16 10 0.1 6500 1 Turns R   

2009 Burden Resistor Val int16 1000 0  50  47.4 Ohms R   

2011  Parent ID  int16 1 1 6 1 N/A R   

2013  KW rating  int16 10 1.2 2400 24 KW R   

                    

2020  Group Number    int16 1 0  100  0  N/A R   

2021  Meter Info Name1         int16 1 0 65535 0 N/A R   

2023  Meter Info Name3         int16 1 0 65535 0 N/A R   

2024  Meter Info Name4         int16 1 0 65535 0 N/A R   

2025  Meter Info Name5         int16 1 0 65535 0 N/A R   
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2026  Meter Info On/Off        int16 1 0 1 1 N/A RW   

2027 
 Max Demand Period 
Setting  

int16 1 0 2 0 N/A RW See  Table 5-9 

2028  KW Fault set limit         int16 1 10 200 80 % RW   

2029 
 KW Fault Reset 
Hysteresis  

int16 1 1 20 10 % RW   

2030  KW Fault Set delay         int16 100 0.1 100 10 Sec RW   

2031  KW Fault Reset delay         int16 100 0.1 100 10 Sec RW   

2032  KVA Fault set limit         int16 1 10 200 80 % RW   

2033 
 KVA Fault Reset 
Hysteresis  

int16 1 1 20 10 % RW   

2034  KVA Fault Set delay         int16 100 0.1 100 10 Sec RW   

2035  KVA Fault Reset delay         int16 100 0.1 100 10 Sec RW   

2036  PF Fault set limit         int16 1 10 90 70 N/A RW   

2037 
 PF Fault Reset 
Hysteresis  

int16 1 1 20 5 N/A RW   

2038  PF Fault Set delay         int16 100 0.1 100 10 Sec RW   

2039  PF Fault Reset delay         int16 100 0.1 100 10 Sec RW   

2040 
 Voltage THD Fault set 
limit   

int16 1 1 20 5 % RW   

2041 
 Voltage THD Fault 
Reset Hysteresis  

int16 1 1 20 1 % RW   

2042 
 Voltage THD Fault Set 
delay  

int16 100 0.1 100 30 Sec RW   

2043 
 Voltage THD Fault 
Reset delay 

int16 100 0.1 100 10 Sec RW   

2044 
 Current THD Fault set 
limit   

int16 1 1 20 5 % RW   

2045 
 Current THD Fault 
Reset Hysteresis   

int16 1 1 20 1 % RW   

2046 
 Current THD Fault Set 
delay  

int16 100 0.1 100 30 Sec RW   

2047 
 Current THD Fault 
Reset delay  

int16 100 0.1 100 10 Sec RW   

2048 
 Frequency Fault set 
limit 

int16 10 0.5 15 3 Hz RW   

2049 
 Frequency Fault Reset 
Hysteresis 

int16 10 0.5 15 0.5 Hz RW   

2050 
 Frequency Fault Set 
delay  

int16 100 0.1 100 10 Sec RW   

2051 
 Frequency Fault Reset 
delay   

int16 100 0.1 100 10 Sec RW   

                    

2052 
 Over Current Alarm Set 
Limit  

int16 1 60 150 80 % RW   

2053 
 Over Current Alarm 
Reset Hysteresis  

int16 1 1 20 5 % RW   

2054 
 Over Current Alarm Set 
Delay 

int16 100 0.1 100 10 Sec RW   

2055 
 Over Current Alarm 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

2056 
 Over Current Warning 
Set Limit  

int16  1 50 145 70 % RW   

2057 
 Over Current Warning 
Reset Hysteresis 

int16 1 1 20 5 % RW   

2058 
 Over Current Warning 
Set Delay 

int16 100 0.1 100 10 Sec RW   

2059 
 Over Current Warning 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

2060 
 Under Current Alarm 
Set Limit  

int16 1 0 99 1 % RW   
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2061 
 Under Current Alarm 
Reset Hysteresis 

int16 1 1 20 1 % RW   

2062 
 Under Current Alarm 
Set Delay  

int16 100 0.1 100 10 Sec RW   

2063 
 Under Current Alarm 
Reset Delay  

int16 100 0.1 100 10 Sec RW   

2064 
 Over Voltage Alarm Set 
Limit  

int16 1 115 125 120 % RW   

2065 
 Over Voltage Alarm 
Reset Hysteresis  

int16 1 1 20 5 % RW   

2066 
 Over Voltage Alarm Set 
Delay  

int16 100 0.1 100 10 Sec RW   

2067 
 Over Voltage Alarm 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

2068 
 Over Voltage Warning 
Set Limit 

int16 1 105 115 110 % RW   

2069 
 Over Voltage Warning 
Reset Hysteresis  

  1 1 20 5 % RW   

2070 
 Over Voltage Warning 
Set Delay  

int16 100 0.1 100 10 Sec RW   

2071 
 Over Voltage Warning 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

2072 
 Under Voltage Alarm 
Set Limit 

int16 1 75 85 80 % RW   

2073 
 Under Voltage Alarm 
Reset Hysteresis  

int16 1 1 20 5 % RW   

2074 
 Under Voltage Alarm 
Set Delay 

int16 100 0.1 100 10 Sec RW   

2075 
 Under Voltage Alarm 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

2076 
 Under Voltage Warning 
Set Limit  

int16 1 85 95 90 % RW   

2077 
 Under Voltage Warning 
Reset Hysteresis   

int16 1 1 20 5 % RW   

2078 
 Under Voltage Warning 
Set Delay  

int16 100 0.1 100 10 Sec RW   

2079 
 Under Voltage Warning 
Reset Delay   

int16 100 0.1 100 10 Sec RW   

2080 
 Frequency Averaging 
Duration 

int16 10 1 10 1 Sec RW   

2081 
 Voltage RMS Averaging 
Duration  

int16 10 1 100 10 Sec RW   

2082 
 Current RMS Averaging 
Duration  

int16 10 1 100 10 Sec RW   

2083  Alarm Delay  int16 100 0.1  100  10  Sec RW   

2084  Warning Delay  int16 100 0.1  100  10  Sec RW   

                    

2091  KVAH Calib Gain   int16 1 1 5 1 N/A RW   

2092  KWH Calib Gain   int16 1 1 5 1 N/A RW   

2093 
 Energy kWH, Upper 
Part   

int16 N/A N/A N/A N/A kWH R   

2094 
 Energy kWH, Lower 
Part   

int16 N/A N/A N/A N/A kWH R   

2095 
 Energy kVAH, Lower 
Part   

int16 N/A N/A N/A N/A kVAH R   

2096 
 Energy kVAH, Upper 
Part   

int16 N/A N/A N/A N/A kVAH R   

2097  Power MD   int16 N/A N/A N/A N/A kW R   

                    

2101 Voltage RMS int16 1 N/A N/A N/A V R   

2102 Max Voltage RMS int16 1 N/A N/A N/A V R   
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2103 Min Voltage RMS int16 1 N/A N/A N/A V R   

2104 Average Voltage RMS int16 1 N/A N/A N/A V R   

2105 Peak Voltage RMS int16 1 N/A N/A N/A V R   

2106 Current RMS int16 1 N/A N/A N/A A R   

2107 Max Current RMS int16 1 N/A N/A N/A A R   

2108 Min Current RMS int16 1 N/A N/A N/A A R   

2109 Average Current RMS int16 1 N/A N/A N/A A R   

2110 Peak Current RMS int16 1 N/A N/A N/A A R   

2111 Current Crest Factor int16 100 N/A N/A N/A N/A R   

2112 Frequency int16 10 N/A N/A N/A Hz R   

2113 Min Frequency int16 10 N/A N/A N/A Hz R   

2114 Max Frequency int16 10 N/A N/A N/A Hz R   

2115 Average Frequency int16 10 N/A N/A N/A Hz R   

2116 Load int16 10 N/A N/A N/A % R   

2117 kW int16 10 N/A N/A N/A kW R   

2118 kVA int16 10 N/A N/A N/A kVA R   

2119 kVAR int16 10 N/A N/A N/A kVAR R   

2120 PF int16 100 N/A N/A N/A N/A R   

2121 Displacement PF int16 100 N/A N/A N/A N/A R   

                    

2126 THD, Voltage int16 100 N/A N/A N/A % R   

2127 THD, Current int16 100 N/A N/A N/A % R   

2128 Voltage Harmonics 1st int16 100 N/A N/A N/A % R   

2129 Voltage Harmonics 3rd int16 100 N/A N/A N/A % R   

2130 Voltage Harmonics 5th int16 100 N/A N/A N/A % R   

2131 Voltage Harmonics 7th int16 100 N/A N/A N/A % R   

2132 Voltage Harmonics 9th int16 100 N/A N/A N/A % R   

2133 Voltage Harmonics 11th int16 100 N/A N/A N/A % R   

2134 Voltage Harmonics 13th int16 100 N/A N/A N/A % R   

2135 Current Harmonics 1st int16 100 N/A N/A N/A % R   

2136 Current Harmonics 3rd int16 100 N/A N/A N/A % R   

2137 Current Harmonics 5th int16 100 N/A N/A N/A % R   

2138 Current Harmonics 7th int16 100 N/A N/A N/A % R   

2139 Current Harmonics 9th int16 100 N/A N/A N/A % R   

2140 Current Harmonics 11th int16 100 N/A N/A N/A % R   

2141 Current Harmonics 13th int16 100 N/A N/A N/A % R   

                    

2145 Alarm Register 1 int16 1 N/A N/A N/A Flags R See Table 5-6 

2146 Warning Register 1 int16 1 N/A N/A N/A Flags R See Table 5-7 

2147 Command Register int16 1 N/A N/A N/A Flags RW See Table 5-8 

 

Registers noted as “Not Implemented” have been defined and will be activated in future releases. 
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5.4.1 Single-phase register input tables 

The alarm, warning and meter command registers each require an integer input to define their settings. 

Table 5-6:  Alarm register 

Bits Description 

0 Over Voltage Alarm 

2 Over Current Alarm 

3 Under Current Alarm 

4 Over KVA Alarm 

5 Over KW Alarm 

6 Low PF Alarm 

7 Voltage Over THD Alarm 

8 Current Over THD Alarm 

9 High Frequency Alarm 

10 Low frequency Alarm 

 

Table 5-7:  Warning register 

Bits Description 

0 Over voltage warning  

1 Under voltage warning  

2 Over current warning  

 

Table 5-8:  Meter Command register 

Bits Description 

0 Writing back default user configurations 

1 Resetting the alarm and warnings 

2 Resetting the min max values 

3 Resetting the energy values 

 

Table 5-9:  Max Demand Period setting 

Bits Description 

0 15 min 

1 30 min 

2 60 min 
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5.5 Three-phase map 

The Three-phase map contains the information of each three-phase meter. It contains user configuration, 

factory configuration, metering data and monitoring data for all three-phase meters.  

PowerView has capacity for up to 67 three-phase meters without neutral, or 60 three-phase meters with 

neutral.  The Three-phase map starts from 40001. Modbus ID offset for each three-phase meter is 350, so 

that all registers assigned to the meter are assigned within that group of 350.  Each meter will start at a 

register id 350 higher than the previous meter’s starting register ID, as noted in Figure 5-2. 

Table 5-10 includes customer accessible registers only. 

Figure 5-2:  Three-phase Modbus map offsets 

 

 

Table 5-10:  Three-phase Modbus register (Meter Index = 1) 

Reg 
No. 

Description Format Scale Min Max Default Unit   Notes 

40001  Meter Rating         int16 1 10 4000 200 I R   

40002  Voltage Rating         int16 1 120 600 120 V R   

40003  Frequency Rating         int16 1 50 60 60 Hz R   

40004  Meter Info ID         int16 1 0 65535 0 N/A R   

40005  Meter Wiring Type int16 1 1 6 2 N/A R See Table 5-20 

40006 
 CT Primary Scale 
Phase  

int16 10 0.1 6500 2500 Turns R   

40007 
 CT Secondary Scale 
Phase  

int16 10 0.1 6500 1 Turns R   

40008 
 CT Primary Scale 
Neutral  

int16 10 0.1 6500 2500 Turns R   

40009 
 CT Secondary Scale 
Neutral  

int16 10 0.1 6500 1 Turns R   

40010 Burden Resistor Val  int16 1000  0  50  47.4 Ohms R   

40019 
 Zero Cutoff Current 
Setting  

int16 1 0 10 2 A R   

40020  Parent ID  int16 1 1 6 1 N/A R   

40022  KW Rating  int16 10 1.2 2400 24 KW R   

40023  LL/LN sensing  int16 1 0 1 1 N/A R   
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40031 Group No  int16 1  0  100  0  N/A RW   

40032  Meter Info Name1         int16 1 0 65535 0 N/A RW   

40034  Meter Info Name3         int16 1 0 65535 0 N/A RW   

40035  Meter Info Name4         int16 1 0 65535 0 N/A RW   

40036  Meter Info Name5         int16 1 0 65535 0 N/A RW   

40037  Meter Info On/Off        int16 1 0 1 1 N/A RW 0- OFF, 1-ON 

40038 
 Max Demand Period 
Setting  

int16 1 0 2 0 N/A RW See Table 5-19  

40039  KW Fault set limit         int16 1 10 200 80 % RW   

40040 
 KW Fault Reset 
Hysteresis  

int16 1 1 20 10 % RW   

40041  KW Fault Set delay         int16 100 0.1 100 10 Sec RW   

40042  KW Fault Reset delay         int16 100 0.1 100 10 Sec RW   

40043  KVA Fault set limit         int16 1 10 200 80 % RW   

40044 
 KVA Fault Reset 
Hysteresis  

int16 1 1 20 10 % RW   

40045  KVA Fault Set delay         int16 100 0.1 100 10 Sec RW   

40046  KVA Fault Reset delay         int16 100 0.1 100 10 Sec RW   

40047  PF Fault set limit         int16 1 10 90 70 % RW   

40048 
 PF Fault Reset 
Hysteresis  

int16 1 1 20 5 % RW   

40049  PF Fault Set delay         int16 100 0.1 100 10 Sec RW   

40050  PF Fault Reset delay         int16 100 0.1 100 10 Sec RW   

40051 
 Voltage THD Fault set 
limit   

int16 1 1 20 5 % RW   

40052 
 Voltage THD Fault 
Reset Hysteresis  

int16 1 1 20 1 % RW   

40053 
 Voltage THD Fault Set 
delay  

int16 100 0.1 100 30 Sec RW   

40054 
 Voltage THD Fault 
Reset delay 

int16 100 0.1 100 10 Sec RW   

40055 
 Current THD Fault set 
limit   

int16 1 1 20 5 % RW   

40056 
 Current THD Fault 
Reset Hysteresis   

int16 1 1 20 1 % RW   

40057 
 Current THD Fault Set 
delay  

int16 100 0.1 100 30 Sec RW   

40058 
 Current THD Fault 
Reset delay  

int16 100 0.1 100 10 Sec RW   

40059 
 Frequency Fault set 
limit 

int16 10 0.5 15 3 Hz RW   

40060 
 Frequency Fault Reset 
Hysteresis 

int16 10 0.5 15 0.5 Hz RW   

40061 
 Frequency Fault Set 
delay  

int16 100 0.1 100 10 Sec RW   

40062 
 Frequency Fault Reset 
delay   

int16 100 0.1 100 10 Sec RW   

                    

40063 
 Over Current Alarm 
Set Limit  

int16 1 60 150 125 % RW   

40064 
 Over Current Alarm 
Reset Hysteresis  

int16 1 1 20 5 % RW   

40065 
 Over Current Alarm 
Set Delay 

int16 100 0.1 100 10 Sec RW   
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40066 
 Over Current Alarm 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

40067 
 Over Current Warning 
Set Limit  

  1 50 145 110 % RW   

40068 
 Over Current Warning 
Reset Hysteresis 

int16 1 1 20 5 % RW   

40069 
 Over Current Warning 
Set Delay 

int16 100 0.1 100 10 Sec RW   

40070 
 Over Current Warning 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

40071 
 Under Current Alarm 
Set Limit  

int16 1 0 99 1 % RW   

40072 
 Under Current Alarm 
Reset Hysteresis 

int16 1 1 20 1 % RW   

40073 
 Under Current Alarm 
Set Delay  

int16 100 0.1 100 10 Sec RW   

40074 
 Under Current Alarm 
Reset Delay  

int16 100 0.1 100 10 Sec RW   

40075 
 Over Voltage Alarm 
Set Limit  

int16 1 115 125 120 % RW   

40076 
 Over Voltage Alarm 
Reset Hysteresis  

int16 1 1 20 5 % RW   

40077 
 Over Voltage Alarm 
Set Delay  

int16 100 0.1 100 10 Sec RW   

40078 
 Over Voltage Alarm 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

40079 
 Over Voltage Warning 
Set Limit 

int16 1 105 115 110 % RW   

40080 
 Over Voltage Warning 
Reset Hysteresis  

  1 1 20 5 % RW   

40081 
 Over Voltage Warning 
Set Delay  

int16 100 0.1 100 10 Sec RW   

40082 
 Over Voltage Warning 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

40083 
 Under Voltage Alarm 
Set Limit 

int16 1 75 85 80 % RW   

40084 
 Under Voltage Alarm 
Reset Hysteresis  

int16 1 1 20 5 % RW   

40085 
 Under Voltage Alarm 
Set Delay 

int16 100 0.1 100 10 Sec RW   

40086 
 Under Voltage Alarm 
Reset Delay 

int16 100 0.1 100 10 Sec RW   

40087 
 Under Voltage Warning 
Set Limit  

int16 1 85 95 90 % RW   

40088 
 Under Voltage Warning 
Reset Hysteresis   

int16 1 1 20 5 % RW   

40089 
 Under Voltage Warning 
Set Delay  

int16 100 0.1 100 10 Sec RW   

40090 
 Under Voltage Warning 
Reset Delay   

int16 100 0.1 100 10 Sec RW   

40091 
 Gnd Current Fault 
Alarm Set Limit   

int16 1 1 25 20 A RW   

40092 
 Gnd Current Fault 
Alarm Reset Hysteresis    

int16 1 1 20 1 A RW   

40093 
 Gnd Current Fault 
Alarm Set Delay  

int16 100 0.1 100 10 Sec RW   

40094 
 Gnd Current Fault 
Alarm Reset Delay   

int16 100 0.1 100 10 Sec RW   

40095 
 Gnd Current Fault 
Warning Set Limit  

int16 1 1 20 10 % RW   

40096 
 Gnd Current Fault 
Warning Reset 
Hysteresis  

int16 1 1 20 1 % RW   
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40097 
 Gnd Current Fault 
Warning Set Delay  

int16 100 0.1 100 10 Sec RW   

40098 
 Gnd Current Fault 
Warning Reset Delay   

int16 100 0.1 100 10 Sec RW   

40099 
 Neutral Current Fault 
Alarm Set Limit   

int16 1 115 150 125 % RW   

40100 
 Neutral Current Fault 
Alarm Reset Hysteresis    

int16 1 1 20 5 % RW   

40101 
 Neutral Current Fault 
Alarm Set Delay  

int16 100 0.1 100 10 Sec RW   

40102 
 Neutral Current Fault 
Alarm Reset Delay   

int16 100 0.1 100 10 Sec RW   

40103 
 Neutral Current Fault 
Warning Set Limit  

int16 1 105 140 110 % RW   

40104 
 Neutral Current Fault 
Warning Reset Limit   

int16 1 1 20 5 % RW   

40105 
 Neutral Current Fault 
Warning Set Delay 

int16 100 0.1 100 10 Sec RW   

40106 
 Neutral Current Fault 
Warning Reset Delay   

int16 100 0.1 100 10 Sec RW   

40107 
 Frequency Averaging 
Duration 

int16 10 1 10 1 Sec RW   

40108 
 Voltage RMS 
Averaging Duration  

int16 10 1 100 10 Sec RW   

40109 
 Current RMS 
Averaging Duration  

int16 10 1 100 10 Sec RW   

40110 Alarm Delay int16 100 0.1  100  10  Sec RW   

40111 Warning Delay int16 100 0.1  100  10  Sec RW   

                    

40112 
 Sag Voltage Lower 
Limit  

int16 1 80 80 80 % RW Not Implemented 

40113 
 Sag Voltage Upper 
Limit   

int16 1 80 90 90 % RW Not Implemented 

40114 
 Sag Voltage Duration 
Lower Limit  

int16 100 0.1 60 0.1 Sec RW Not Implemented 

40115 
 Sag Voltage Duration 
Upper Limit   

int16 100 60 60 60 Sec RW Not Implemented 

40116 
 Outage Voltage Lower 
Limit  

int16 1 0 0 0 % RW Not Implemented 

40117 
 Outage Voltage Upper 
Limit   

int16 1 0 80 80 % RW Not Implemented 

40118 
 Outage Voltage 
Duration Lower Limit 

int16 1 60 1000 60 Sec RW Not Implemented 

40119 
 Outage Voltage 
Duration Upper Limit   

int16 1 1000 1000 1000 Sec RW Not Implemented 

40120 
 Dropout Voltage Lower 
Limit  

int16 1 0 0 0 % RW Not Implemented 

40121 
 Dropout Voltage Upper 
Limit   

int16 1 0 80 80 % RW Not Implemented 

40122 
 Dropout Voltage 
Duration Lower Limit 

int16 100 0.1 60 0.1 Sec RW Not Implemented 

40123 
 Dropout Voltage 
Duration Upper Limit  

int16 100 60 60 60 Sec RW Not Implemented 

40124 
 Over Voltage Lower 
Limit  

int16 1 110 200 110 % RW Not Implemented 

40125 
 Over Voltage Upper 
Limit   

int16 1 200 200 200 % RW Not Implemented 

40126 
 Over Voltage Duration 
Lower Limit  

int16 1 60 1000 60 Sec RW Not Implemented 
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40127 
 Over Voltage Duration 
Upper Limit   

int16 1 1000 1000 1000 Sec RW Not Implemented 

40128 
 Swell Voltage Lower 
Limit  

int16 1 120 200 120 % RW Not Implemented 

40129 
 Swell Voltage Upper 
Limit  

int16 1 200 200 200 % RW Not Implemented 

40130 
 Swell Voltage Duration 
Lower Limit 

int16 100 0.1 60 0.1 Sec RW Not Implemented 

40131 
 Swell Voltage Duration 
Upper Limit  

int16 100 60 60 60 Sec RW Not Implemented 

40132 
 Temp OV Voltage 
Lower Limit  

int16 1 180 200 180 % RW Not Implemented 

40133 
 Temp OV Voltage 
Upper Limit  

int16 1 200 200 200 % RW Not Implemented 

40134 
 Temp OV Voltage 
Duration Lower Limit 

int16 1 0 0 0 Sec RW Not Implemented 

40135 
 Temp OV Voltage 
Duration Upper Limit 

int16 1 0 0 0 Sec RW Not Implemented 

                    

40145 
KVAH Calib Gain A 
Phase   

int16 1 1 5 1 N/A R   

40146 
KVAH Calib Gain B 
Phase   

int16 1 1 5 1 N/A R   

40147 
KVAH Calib Gain C 
Phase   

int16 1 1 5 1 N/A R   

40148 
KWH Calib Gain A 
Phase   

int16 1 1 5 1 N/A R   

40149 
KWH Calib Gain B 

Phase   
int16 1 1 5 1 N/A R   

40150 
KWH Calib Gain C 
Phase   

int16 1 1 5 1 N/A R   

40151 Total KVAH Calib Gain   int16 1 1 5 1 N/A R   

40152 Total KWH Calib Gain   int16 1 1 5 1 N/A R   

40153 
 Energy kWH, øA Phase 
Upper Part   

int16 N/A N/A N/A N/A kWH R   

40154 
 Energy kWH, øA Phase 
Lower Part   

int16 N/A N/A N/A N/A kWH R   

40155 
 Energy kWH, øB Phase 
Upper Part   

int16 N/A N/A N/A N/A kWH R   

40156 
 Energy kWH, øB Phase 
Lower Part   

int16 N/A N/A N/A N/A kWH R   

40157 
 Energy kWH, øC Phase 
Upper Part   

int16 N/A N/A N/A N/A kWH R   

40158 
 Energy kWH, øC Phase 
Lower Part   

int16 N/A N/A N/A N/A kWH R   

40159 
 Energy kWH, Total 
Upper Part   

int16 N/A N/A N/A N/A kWH R   

40160 
 Energy kWH, Total 
Lower Part   

int16 N/A N/A N/A N/A kWH R   

40161 
 Energy kVAH, øA 
Upper Part   

int16 N/A N/A N/A N/A kVAH R   

40162 
 Energy kVAH, øA 
Phase Lower Part   

int16 N/A N/A N/A N/A kVAH R   

40163 
 Energy kVAH, øB 
Phase Upper Part   

int16 N/A N/A N/A N/A kVAH R   

40164 
 Energy kVAH, øB 
Phase Lower Part   

int16 N/A N/A N/A N/A kVAH R   

40165 
 Energy kVAH, øC 
Phase Upper Part   

int16 N/A N/A N/A N/A kVAH R   

40166 
 Energy kVAH, øC 
Phase Lower Part   

int16 N/A N/A N/A N/A kVAH R   

40167 
 Energy kVAH, Total 
Upper Part   

int16 N/A N/A N/A N/A kVAH R   

40168 
 Energy kVAH, Total 
Lower Part   

int16 N/A N/A N/A N/A kVAH R   

40169  Power MD, øA int16 N/A N/A N/A N/A kW R   
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40170  Power MD, øB  int16 N/A N/A N/A N/A kW R   

40171  Power MD, øC  int16 N/A N/A N/A N/A kW R   

40172  Power MD, Total  int16 N/A N/A N/A N/A kW R   

                    

40175 Voltage RMS, øA-B int16 1 N/A N/A N/A V R   

40176 Voltage RMS, øB-C int16 1 N/A N/A N/A V R   

40177 Voltage RMS, øC-A int16 1 N/A N/A N/A V R   

40178 Voltage RMS, øA-N int16 1 N/A N/A N/A V R   

40179 Voltage RMS, øB-N int16 1 N/A N/A N/A V R   

40180 Voltage RMS, øC-N int16 1 N/A N/A N/A V R   

40181 Max Voltage RMS, øA-N int16 1 N/A N/A N/A V R 
For PDU input, Max 
Voltage RMS, øA-B 

40182 Max Voltage RMS, øB-N int16 1 N/A N/A N/A V R 
For PDU input, Max 
Voltage RMS, øB-C 

40183 Max Voltage RMS, øC-N int16 1 N/A N/A N/A V R 
For PDU input, Max 
Voltage RMS, øC-A 

40184 Min Voltage RMS, øA-N int16 1 N/A N/A N/A V R 
For PDU input, Min 
Voltage RMS, øA-B 

40185 Min Voltage RMS, øB-N int16 1 N/A N/A N/A V R 
For PDU input, Min 
Voltage RMS, øB-C 

40186 Min Voltage RMS, øC-N int16 1 N/A N/A N/A V R 
For PDU input, Min 
Voltage RMS, øC-A 

40187 
Average Voltage RMS, 
øA-N 

int16 1 N/A N/A N/A V R 
For PDU input, Average 

Voltage RMS, øA-B 

40188 
Average Voltage RMS, 
øB-N 

int16 1 N/A N/A N/A V R 
For PDU input, Max 
Voltage RMS, øB-C 

40189 
Average Voltage RMS, 
øC-N 

int16 1 N/A N/A N/A V R 
For PDU input, Average 

Voltage RMS, øC-A 

40190 
Peak Voltage RMS, øA-
N 

int16 1 N/A N/A N/A V R 
For PDU input, Average 

Voltage RMS, øA-B 

40191 
Peak Voltage RMS, øB-
N 

int16 1 N/A N/A N/A V R 
For PDU input, Average 

Voltage RMS, øB-C 

40192 
Peak Voltage RMS, øC-
N 

int16 1 N/A N/A N/A V R 
For PDU input, Average 

Voltage RMS, øC-A 

40193 Current RMS, øA int16 1 N/A N/A N/A A R   

40194 Current RMS, øB int16 1 N/A N/A N/A A R   

40195 Current RMS, øC int16 1 N/A N/A N/A A R   

40196 Current RMS, Neutral int16 1 N/A N/A N/A A R   

40197 Current RMS, Ground int16 1 N/A N/A N/A A R   

40198 Max Current RMS, øA int16 1 N/A N/A N/A A R   

40199 Max Current RMS, øB int16 1 N/A N/A N/A A R   

40200 Max Current RMS, øC int16 1 N/A N/A N/A A R   

40201 
Max Current RMS, 
Neutral 

int16 1 N/A N/A N/A A R   
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40202 
Max Current RMS, 
Ground 

int16 1 N/A N/A N/A A R   

40203 Min Current RMS, øA int16 1 N/A N/A N/A A R   

40204 Min Current RMS, øB int16 1 N/A N/A N/A A R   

40205 Min Current RMS, øC int16 1 N/A N/A N/A A R   

40206 
Min Current RMS, 
Neutral 

int16 1 N/A N/A N/A A R   

40207 
Min Current RMS, 
Ground 

int16 1 N/A N/A N/A A R   

40208 
Average Current RMS, 
øA 

int16 1 N/A N/A N/A A R   

40209 
Average Current RMS, 
øB 

int16 1 N/A N/A N/A A R   

40210 
Average Current RMS, 
øC 

int16 1 N/A N/A N/A A R   

40211 
Average Current RMS, 
Neutral 

int16 1 N/A N/A N/A A R   

40212 
Average Current RMS, 
Ground 

int16 1 N/A N/A N/A A R   

40213 Peak Current RMS, øA int16 1 N/A N/A N/A A R   

40214 Peak Current RMS, øB int16 1 N/A N/A N/A A R   

40215 Peak Current RMS, øC int16 1 N/A N/A N/A A R   

40216 
Peak Current RMS, 
Neutral 

int16 1 N/A N/A N/A A R   

40217 
Peak Current RMS, 
Ground 

int16 1 N/A N/A N/A A R   

40218 
Current Crest Factor, 
øA 

int16 100 N/A N/A N/A N/A R   

40219 
Current Crest Factor, 
øB 

int16 100 N/A N/A N/A N/A R   

40220 
Current Crest Factor, 
øC 

int16 100 N/A N/A N/A N/A R   

40221 Frequency int16 10 N/A N/A N/A Hz R   

40222 Min Frequency int16 10 N/A N/A N/A Hz R   

40223 Max Frequency int16 10 N/A N/A N/A Hz R   

40224 Average Frequency int16 10 N/A N/A N/A Hz R   

40225 Load, øA int16 10 N/A N/A N/A % R   

40226 Load, øB int16 10 N/A N/A N/A % R   

40227 Load, øC int16 10 N/A N/A N/A % R   

40228 Load, Total int16 10 N/A N/A N/A % R   

40229 kW, øA int16 10 N/A N/A N/A kW R   

40230 kW, øB int16 10 N/A N/A N/A kW R   

40231 kW, øC int16 10 N/A N/A N/A kW R   

40232 kW, Total   10 N/A N/A   kW R   

40233 kVA, øA int16 10 N/A N/A N/A kVA R   

40234 kVA, øB int16 10 N/A N/A N/A kVA R   

40235 kVA, øC int16 10 N/A N/A N/A kVA R   

40236 kVA, Total int16 10 N/A N/A N/A kVA R   

40237 kVAR, øA int16 10 N/A N/A N/A kVAR R   

40238 kVAR, øB int16 10 N/A N/A N/A kVAR R   

40239 kVAR, øC int16 10 N/A N/A N/A kVAR R   

40240 kVAR, Total int16 10 N/A N/A N/A kVAR R   
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40241 PF, øA int16 100 N/A N/A N/A N/A R   

40242 PF, øB int16 100 N/A N/A N/A N/A R   

40243 PF, øC int16 100 N/A N/A N/A N/A R   

40244 PF int16 100 N/A N/A N/A N/A R   

40245 
PF, Displacement 
factor, øA 

int16 100 N/A N/A N/A N/A R Not Implemented 

40246 
PF, Displacement 
factor, øB 

int16 100 N/A N/A N/A N/A R Not Implemented 

40247 
PF, Displacement 
factor, øC 

int16 100 N/A N/A N/A N/A R Not Implemented 

                    

40253 THD, Voltage, øA int16 100 N/A N/A N/A % R   

40254 THD, Voltage, øB int16 100 N/A N/A N/A % R   

40255 THD, Voltage, øC int16 100 N/A N/A N/A % R   

40256 THD, Current øA int16 100 N/A N/A N/A % R   

40257 THD, Current øB int16 100 N/A N/A N/A % R   

40258 THD, Current øC int16 100 N/A N/A N/A % R   

40259 
Voltage Harmonics 1st, 
øA 

int16 100 N/A N/A N/A % R   

40260 
Voltage Harmonics 3rd, 
øA 

int16 100 N/A N/A N/A % R   

40261 
Voltage Harmonics 5th, 
øA 

int16 100 N/A N/A N/A % R   

40262 
Voltage Harmonics 7th, 
øA 

int16 100 N/A N/A N/A % R   

40263 
Voltage Harmonics 9th, 
øA 

int16 100 N/A N/A N/A % R   

40264 
Voltage Harmonics 
11th, øA 

int16 100 N/A N/A N/A % R   

40265 
Voltage Harmonics 
13th, øA 

int16 100 N/A N/A N/A % R   

40266 
Voltage Harmonics 1st, 
øB 

int16 100 N/A N/A N/A % R   

40267 
Voltage Harmonics 3rd, 
øB 

int16 100 N/A N/A N/A % R   

40268 
Voltage Harmonics 5th, 
øB 

int16 100 N/A N/A N/A % R   

40269 
Voltage Harmonics 7th, 
øB 

int16 100 N/A N/A N/A % R   

40270 
Voltage Harmonics 9th, 
øB 

int16 100 N/A N/A N/A % R   

40271 
Voltage Harmonics 
11th, øB 

int16 100 N/A N/A N/A % R   

40272 
Voltage Harmonics 
13th, øB 

int16 100 N/A N/A N/A % R   

40273 
Voltage Harmonics 1st, 
øC 

int16 100 N/A N/A N/A % R   

40274 
Voltage Harmonics 3rd, 

øC 
int16 100 N/A N/A N/A % R   

40275 
Voltage Harmonics 5th, 
øC 

int16 100 N/A N/A N/A % R   

40276 
Voltage Harmonics 7th, 
øC 

int16 100 N/A N/A N/A % R   

40277 
Voltage Harmonics 9th, 
øC 

int16 100 N/A N/A N/A % R   

40278 
Voltage Harmonics 
11th, øC 

int16 100 N/A N/A N/A % R   

40279 
Voltage Harmonics 
13th, øC 

int16 100 N/A N/A N/A % R   
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40280 
Current Harmonics 1st, 
øA 

int16 100 N/A N/A N/A % R   

40281 
Current Harmonics 3rd, 
øA 

int16 100 N/A N/A N/A % R   

40282 
Current Harmonics 5th, 
øA 

int16 100 N/A N/A N/A % R   

40283 
Current Harmonics 7th, 
øA 

int16 100 N/A N/A N/A % R   

40284 
Current Harmonics 9th, 
øA 

int16 100 N/A N/A N/A % R   

40285 
Current Harmonics 
11th, øA 

int16 100 N/A N/A N/A % R   

40286 
Current Harmonics 
13th, øA 

int16 100 N/A N/A N/A % R   

40287 
Current Harmonics 
15th, øA 

int16 100 N/A N/A N/A % R   

40288 
Current Harmonics 
17th, øA 

int16 100 N/A N/A N/A % R   

40289 
Current Harmonics 
19th, øA 

int16 100 N/A N/A N/A % R   

40290 
Current Harmonics 
21st, øA 

int16 100 N/A N/A N/A % R   

40291 
Current Harmonics 
23rd, øA 

int16 100 N/A N/A N/A % R   

40292 
Current Harmonics 
25th, øA 

int16 100 N/A N/A N/A % R   

40293 
Current Harmonics 
27th, øA 

int16 100 N/A N/A N/A % R   

40294 
Current Harmonics 
29th, øA 

int16 100 N/A N/A N/A % R   

40295 
Current Harmonics 
31st, øA 

int16 100 N/A N/A N/A % R   

40296 
Current Harmonics 
33rd, øA 

int16 100 N/A N/A N/A % R   

40297 
Current Harmonics 
35th, øA 

int16 100 N/A N/A N/A % R   

40298 
Current Harmonics 1st, 
øB 

int16 100 N/A N/A N/A % R   

40299 
Current Harmonics 3rd, 
øB 

int16 100 N/A N/A N/A % R   

40300 
Current Harmonics 5th, 
øB 

int16 100 N/A N/A N/A % R   

40301 
Current Harmonics 7th, 
øB 

int16 100 N/A N/A N/A % R   

40302 
Current Harmonics 9th, 
øB 

int16 100 N/A N/A N/A % R   

40303 
Current Harmonics 
11th, øB 

int16 100 N/A N/A N/A % R   

40304 
Current Harmonics 
13th, øB 

int16 100 N/A N/A N/A % R   

40305 
Current Harmonics 
15th, øB 

int16 100 N/A N/A N/A % R   

40306 
Current Harmonics 
17th, øB 

int16 100 N/A N/A N/A % R   

40307 
Current Harmonics 
19th, øB 

int16 100 N/A N/A N/A % R   

40308 
Current Harmonics 
21st, øB 

int16 100 N/A N/A N/A % R   

40309 
Current Harmonics 
23rd, øB 

int16 100 N/A N/A N/A % R   

40310 
Current Harmonics 
25th, øB 

int16 100 N/A N/A N/A % R   

40311 
Current Harmonics 
27th, øB 

int16 100 N/A N/A N/A % R   

40312 
Current Harmonics 
29th, øB 

int16 100 N/A N/A N/A % R   

40313 
Current Harmonics 
31st, øB 

int16 100 N/A N/A N/A % R   
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40314 
Current Harmonics 
33rd, øB 

int16 100 N/A N/A N/A % R   

40315 
Current Harmonics 
35th, øB 

int16 100 N/A N/A N/A % R   

40316 
Current Harmonics 1st, 
øC 

int16 100 N/A N/A N/A % R   

40317 
Current Harmonics 3rd, 
øC 

int16 100 N/A N/A N/A % R   

40318 
Current Harmonics 5th, 
øC 

int16 100 N/A N/A N/A % R   

40319 
Current Harmonics 7th, 
øC 

int16 100 N/A N/A N/A % R   

40320 
Current Harmonics 9th, 
øC 

int16 100 N/A N/A N/A % R   

40321 
Current Harmonics 
11th, øC 

int16 100 N/A N/A N/A % R   

40322 
Current Harmonics 
13th, øC 

int16 100 N/A N/A N/A % R   

40323 
Current Harmonics 
15th, øC 

int16 100 N/A N/A N/A % R   

40324 
Current Harmonics 
17th, øC 

int16 100 N/A N/A N/A % R   

40325 
Current Harmonics 
19th, øC 

int16 100 N/A N/A N/A % R   

40326 
Current Harmonics 
21st, øC 

int16 100 N/A N/A N/A % R   

40327 
Current Harmonics 
23rd, øC 

int16 100 N/A N/A N/A % R   

40328 
Current Harmonics 
25th, øC 

int16 100 N/A N/A N/A % R   

40329 
Current Harmonics 
27th, øC 

int16 100 N/A N/A N/A % R   

40330 
Current Harmonics 
29th, øC 

int16 100 N/A N/A N/A % R   

40331 
Current Harmonics 
31st, øC 

int16 100 N/A N/A N/A % R   

40332 
Current Harmonics 
33rd, øC 

int16 100 N/A N/A N/A % R   

40333 
Current Harmonics 
35th, øC 

int16 100 N/A N/A N/A % R   

40334 Positive Sequence int16 1 N/A N/A N/A V R Not Implemented 

40335 Negative Sequence int16 1 N/A N/A N/A V R Not Implemented 

40336 Zero Sequence int16 1 N/A N/A N/A V R Not Implemented 

40337 Unbalance Factor int16 10 N/A N/A N/A N/A R   

                    

40339 Alarm Register 1 int16 N/A N/A N/A N/A Flags R See Table 5-11 

40340 Alarm Register 2 int16 N/A N/A N/A N/A Flags R See Table 5-12 

40341 Alarm Register 3 int16 N/A N/A N/A N/A Flags R See Table 5-13 

40342 Warning Register 1 int16 N/A N/A N/A N/A Flags R See Table 5-14 

40343 Warning Register 2 int16 N/A N/A N/A N/A Flags R See Table 5-15 

40344 Warning Register 3 int16 N/A N/A N/A N/A Flags R See Table 5-16 

40345 
Alarm Register 
Common 

int16 N/A N/A N/A N/A Flags R See Table 5-17 

40346 Command Register int16 N/A N/A N/A N/A Flags RW See Table 5-18 

Registers noted as “Not Implemented” have been defined and will be activated in future releases. 
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5.5.1 Three-phase register input tables 

The alarm, warning and meter command registers each require an integer input to define their settings. 

Table 5-11:  Alarm register 1 

Bits Description 

0 Over Voltage Alarm, øA 

1 Under Voltage Alarm, øA 

2 Over Current Alarm, øA 

3 Under Current Alarm, øA 

4 Over KVA Alarm, øA 

5 Over KW Alarm, øA 

6 Low PF Alarm, øA 

7 Voltage Over THD Alarm, øA 

8 Current Over THD Alarm, øA 

10 Low frequency Alarm 

11 Neutral Current Fault 

12 Ground Current fault 

 

Table 5-12:  Alarm register 2 

Bits Description 

0 Over Voltage Alarm, øB 

1 Under Voltage Alarm, øB 

2 Over Current Alarm, øB 

3 Under Current Alarm, øB 

4 Over KVA Alarm, øB 

5 Over KW Alarm, øB 

6 Low PF Alarm, øB 

7 Voltage Over THD Alarm, øB 

8 Current Over THD Alarm, øB 

 

Table 5-13:  Alarm register 3 

Bits Description 

0 Over Voltage Alarm, øC 

1 Under Voltage Alarm, øC 

2 Over Current Alarm, øC 

3 Under Current Alarm, øC 

4 Over KVA Alarm, øC 

5 Over KW Alarm, øC 

6 Low PF Alarm, øC 

7 Voltage Over THD Alarm, øC 

8 Current Over THD Alarm, øC 
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Table 5-14:  Warning register 1 

Bits Description 

0 Over voltage warning, øA 

1 Under voltage warning, øA 

2 Over current warning, øA 

11 Neutral current warning 

12 Ground current warning 

 

Table 5-15:  Warning register 2 

Bits Description 

0 Over voltage warning, øB 

1 Under voltage warning, øB 

2 Over current warning, øB 

 

 

Table 5-16:  Warning register 3 

Bits Description 

0 Over voltage warning, øC 

1 Under voltage warning, øC 

2 Over current warning, øC 

 

Table 5-17:  Alarm register common 

Bits Description 

0 Phase sequence warning 

1 Phase loss warning 

2 Load unbalance 

3 Voltage unbalance 

4 Over kva alarm total 

5 Over kw alarm total 

6 Low pf alarm total 
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Table 5-18:  Meter Command register 

Bits Description 

0 Writing back default user configurations 

1 Resetting the alarm and warnings 

2 Resetting the min max values 

3 Resetting the energy values 

 

Table 5-19:  Max Demand Period setting 

Value Description 

0 15 min 

1 30 min 

2 60 min 

 

Table 5-20:  Meter Wiring Type 

Value Description 

1 Meter Type 3L 

2 Meter Type 3LN 

3 Meter Type 3LNG 

4 Meter Type 3L without Neutral 

5 Meter Type 2L without Neutral 

6 Meter Type 2L with one current sensing 
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5.6 Thermal and User Input maps 

These maps contain thermal and user input data.  Modbus IDs in the range from 63451 to 65535 are 

allocated for the Thermal and User input maps. 

5.6.1 Input Card map 

The Input map contains the status information of each input sensor, using one bit per sensor.  Status can 

be either 0 or 1.  

PowerView has capacity for up to 150 input sensors, 25 per card, up to 6 cards.  Each card uses two 16-

bit registers, with sensors 1 to 16 on the first register and 17 to 25 on the second register.  The registers 

output strings of 0’s and 1’s, up to 16 digits if all sensors on that register are configured.  The input 

configuration section starts from 63451.  

 

Table 5-21:  Input card Modbus register 

Reg. 
No. 

Description Format Scale Min Max Default 
Access 
Type 

Note 

63451  Input Board1 Status1   int16 1 N/A N/A N/A R   

63452  Input Board1 Status2   int16 1 N/A N/A N/A R   

63453  Input Board2 Status1   int16 1 N/A N/A N/A R   

63454  Input Board2 Status2   int16 1 N/A N/A N/A R   

63455  Input Board3 Status1   int16 1 N/A N/A N/A R   

63456  Input Board3 Status2   int16 1 N/A N/A N/A R   

63457  Input Board4 Status1   int16 1 N/A N/A N/A R   

63458  Input Board4 Status2   int16 1 N/A N/A N/A R   

63459  Input Board5 Status1   int16 1 N/A N/A N/A R   

63460  Input Board5 Status2   int16 1 N/A N/A N/A R   

63461  Input Board6 Status1   int16 1 N/A N/A N/A R   

63462  Input Board6 Status2   int16 1 N/A N/A N/A R   

63471   Debounce Setting int16 1 0 20000 2 RW   
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5.6.2 Thermocouple Card map 

The Thermocouple map contains the information of each thermal sensor.  It contains configuration and 

metering data for all thermal sensors.  

PowerView has capacity for up to 90 thermal sensors, 15 per card, up to 6 cards.  The Thermocouple Card 

map consists of two sections.  The thermal configuration section starts from 64001. Modbus ID offset for 

each thermal sensor configuration is 10, so that all registers assigned to the meter are assigned within 

that group of 10.  Each sensor configuration will start at a register id 10 higher than the previous sensor’s 

starting register ID, as noted in Figure 5-3. 

Figure 5-3:  Thermal configuration map offsets 

 

 

The thermal metering section starts from 63501. Modbus ID offset for each thermal sensor configuration 

is 5, so that all registers assigned to the meter are assigned within that group of 5.  Each sensor metering 

will start at a register id 5 higher than the previous sensor’s starting register ID, as noted in Figure 5-4. 

Figure 5-4:  Thermal metering map offsets 
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Table 5-22:  Thermocouple Card register (index=1) 

Thermal Configuration 

Reg 
No. 

Description Format Scale Min Max Default Unit 
Access 
Type 

Notes 

64001 THERMAL_PROBE_ID  int16 1 1 65535 1 N/A RW   

64002 THERMAL_SENSOR_TYPE  int16 1 0 3 1 N/A RW See Table 5-23 

64003 THERMAL_ALARM_LIM  int16 1 5 500 200 °C RW   

64004 THERMAL_ALARM_DELAY  int16 1 1 60 10 Secs RW   

64005 THERMAL_WARN_LIM  int16 1 5 400 150 °C RW   

64006 THERMAL_WARN_DELAY  int16 1 1 60 10 Secs RW   

64007 THERMAL_SENSOR_ONOFF int16 1 0 65535 0 N/A RW   

64008 THERMAL_RESERVED2  int16 1 0 1 0 N/A RW   

64009 THERMAL_RESERVED3  int16 1 0 65535 0 N/A RW   

64010 THERMAL_RESERVED4  int16 1 0 65535 0 N/A RW   

                   

Thermal Metering/Status 

63501 THERMAL_STATUS int16 N/A N/A N/A N/A Flags R  See Table 5-24 

63502 THERMAL_VAL int16 N/A N/A N/A N/A °C R   

63503 THERMAL_MAX_VAL int16 N/A N/A N/A N/A °C R   

63504 THERMAL_MIN_VAL int16 N/A N/A N/A N/A °C R   

63505 Reserved int16 N/A N/A N/A N/A Flags R   

 

5.6.2.1 Thermal map register input tables 

Table 5-23:  Thermal Sensor Type 

Value Description 

0 T Type 

1 K Type 

2 J Type 

3 E Type 

 
 
 

Table 5-24:  Thermal Status 

Bits Description 

0 HighTempAlarm 

1 HighTemp Warning 

 

 



48  94-1100-00002861 D0 EN│Cyberex® Power Distribution Unit 

5.6.3 Custom Group map 

The custom group map contains the information of each group. PowerView has capacity for up to 50 

custom groups.  The Custom group map starts from 65001. Modbus ID offset for each group is 10, so that 

all registers assigned to the meter are assigned within that group of 10.  Each group will start at a register 

id 10 higher than the previous group’s starting register ID, as noted in Figure 5-1. 

 

Table 5-25:  Custom Group Modbus map offsets 

 

 

Table 5-26:  Custom Group Modbus register (Meter Index = 1) 

Reg No.   Description Format Scale Min Max Default Unit 
Access 
Type 

Notes 

65001   kW int16 10 N/A N/A N/A kW R   

65002   Energy kWH, Upper Part   int16 N/A N/A N/A N/A kWH R   

65003   Energy kWH, Lower Part   int16 N/A N/A N/A N/A kWH R   

65004   Group Status register int16 N/A N/A N/A N/A N/A R   

65005   Reserved int16 N/A N/A N/A N/A N/A R   

65006   Reserved int16 N/A N/A N/A N/A N/A R   

65007   Reserved int16 N/A N/A N/A N/A N/A R   

65008   Reserved int16 N/A N/A N/A N/A N/A R   

65009   Reserved int16 N/A N/A N/A N/A N/A R   

65010   Reserved int16 N/A N/A N/A N/A N/A R 
  

  

5.6.3.1 Custom Group register input table 

Table 5-27:  Group Status register 

Value Description 

0 Normal 

1 Alarm 

2 Warning 



 

 
 Cyberex® Power Distribution Unit│94-1100-00002861 D0 EN  49 

— 

6 Configuration tool 

System configuration is typically completed by ABB Service personnel.  Contact ABB service for changes 

that require Level 2 access. 

6.1 Program Description 

The PowerView Configuration Tool is a PC based program that can be used for configuring and monitoring 

the PowerView Monitoring System.   

6.2 PC System Requirements 

• IBM Pentium or higher (or compatible) PC with two free USB ports and one USB to RS-485 adapter, 

and a minimum screen resolution setting of 1366 by 768.   

• Microsoft Windows 7 or higher.   

• Microsoft Excel 2010 (or higher) is needed for certain functions regarding Captured Settings.   

6.3 Setup 

6.3.1 Installation 

This program can be installed by double-clicking the "PowerViewConfigTool_Setup_vX_X_X_X.exe" file 

provided and following the on-screen instructions.   

This setup program will put a shortcut on the Desktop and in the Windows Start>All Programs folder.   

6.3.2 Initial Login 

When the program is started, the main window will appear as shown in Figure 6-1 below.   

Figure 6-1:  Main Configuration Tool window 
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An initial login is required before using the program.  Once you are logged in, you have the option of 

logging out between uses, or remaining logged in for future uses.  To log in, click File>Login in the main 

menu bar.  The Login dialog box will open as shown below.   

  

Figure 6-2:  Login window 

 

There are three login levels as shown in Table 6-1 below.   

Table 6-1:  Login levels 

Level Login name Default Password Permissions 

0 Default Default 
Permission to view meter readings and settings 

only.   

1 Admin Admin 

In addition to those of Level 0 (above), permission 

to change the program's settings, modify PowerView 

setpoints, and change the program's passwords for 

Levels 0-1. 

2 Supervisor 
<reserved for 

service> 
Reserved for ABB Service  

 

When you are finished using the program, you have the option of logging out or remaining logged in for 

the next use. To log out, click File>Logout in the main menu bar.   

6.3.3 PC Setup 

The connection from PC to the unit will be made through the unit’s Modbus user interface connection.  See 

your unit’s manual for the correct location. 

To configure the ports on the PC, open the "PC Setup" window (shown below) by clicking "File > PC Setup" 

on the menu bar.   

The default Modbus settings of this program and the module are 115200 baud and Slave ID 1 as shown in 

Figure 6-3 below.  The USB Service Port also works at 115200 baud, and it is not configurable.   

You will need to change the COM Ports settings in the "PC Setup" window to match those assigned on your 

PC.  A "Device Mgr." button in this window is provided to open the Windows Device Manager, where you 

can see the COM Port assignments for these ports.  After setting the COM Ports, click the "Save" button.  

If everything is connected and configured correctly, you should start seeing activity in the status bar at 

the bottom of the main window as shown in the screenshot down below in Figure 6-4.  The Service port is 

reserved for service setup by qualified ABB service personnel. 
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Figure 6-3:  PC Setup dialog box 

 

Figure 6-4:  System Configuration window 
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6.4 View Menu 

The View menu is shown below in Figure 6-5.   

Any combination of the items in the View menu can be selected to view.  When an item is selected, its 

window will open, and a checkmark will appear next to the item in the menu.  The item can be unselected 

by either re-clicking the selected item in the menu or by closing its window.   

Figure 6-5:  View menu 

 

 

The program remembers the views selected when the program is closed and reopened later.  It also 

remembers the positions of open windows.   
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6.4.1 System Configuration 

The "System Configuration" window (shown below), shows the basic metering configuration of the 

PowerView module and the alarm/warning status for each meter.   

Figure 6-6:  System Configuration window 
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6.4.2 Meter Settings/Readings windows 

These windows show all the settings and readings for each meter in the PowerView module as shown 

below.  The alarm/warning status for each meter is also included in the Readings windows.   

Figure 6-7:  Meter Settings and Readings windows 
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6.4.2.1 Copying and Capturing Data 

When logged in at Level 0 or 1, you can copy the data from each of these four windows by right-clicking 

on the table and selecting "Copy All to Clipboard" or "Capture to File" in the popup menu as shown below.  

The data will be in the tab-delimited format.  When a window is first opened, you must wait for the table 

to be fully populated before this popup menu will appear.  (The word, "Updated" will appear in the 

window's title bar when the table is fully populated.) 

Figure 6-8:  Copying Meter Data window 

 

6.4.2.2 Modifying Meter Settings 

When logged in at Level 1, you can change settings in the Settings windows by double-clicking on the 

parameter you want to change and entering the new setting in the popup dialog box that appears as 

shown below.  Note that some parameters can only be changed with Level 2 access, as they are typically 

not changed after factory setup. 

Figure 6-9:  Meter Settings Update window 

 

 

A "Global Settings feature is also available only for the Over/Under Current Alarm/Warning setpoints, 

which include the following Modbus register ranges and the equivalent registers for each existing meter.  

Single-Phase Table: Reg. 2052 to 2063 

Three-Phase Table: Reg. 40063 to 40074 

To use this global feature, double-click the item in the "Description" column instead of on the setting 

value.   
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6.4.3 Branch and Sub-feed Panelboard windows 

These windows show the current or voltage readings for each branch or sub-feed meter in the PowerView 

module as shown below.  The alarm/warning status for each meter is also included indicated by the color 

of the cells in the first columns.  The middle columns show the ADC mapping info: Slot#/Connector#/Pin# 

(Channel No.)   

Figure 6-10:  Standard Panelboard Branch Circuit view 

 

Figure 6-11:  Column Width Panelboard Branch Circuit view 

 

Figure 6-12:  Sub-feed Circuits with neutrals view 
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Figure 6-13:  Sub-feed Circuits without neutrals view 

 

 

6.4.3.1 Changing View Modes 

To change to different views in each window, right-click on any of the tables to bring up the popup menu 

as shown below.  This screenshot shows the window with "Show Voltage /Channel Mapping" view selected.  

The other selections are "Show Parent ID", where the middle columns show Parent IDs for each meter, 

and "Column-Width View", which is applicable only with the Branch windows. 

Figure 6-14:  Branch Circuit Pop-up menu 
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6.4.3.2 Accessing Additional Metering Information 

You can access additional info for each meter in the View windows shown above, by clicking on the meter 

row in the table.  In the example screenshot below, the "B5" branch meter was clicked, which brought up 

the Readings window and selected the B5 meter column, where you can see all of readings and 

alarm/warning statuses for that meter.   

Figure 6-15:  Branch Meter window 
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In the example screenshot below, the "S1" sub-feed meter was clicked, which brought up the separate 

Sub-feed window for that meter along with the selected SF1 meter on the 3ø Meter Readings window.   

Figure 6-16:  Sub-feed and Three-phase Meter windows 
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6.4.4 Panel and PDU windows 

These windows show the readings and alarm/warning status for the available panel and PDU meters.  The 

ADC mapping info is also provided: Slot#/Connector#/Pin# (Channel No.). 

Clicking on the tables in the Panel and PDU windows opens windows with details on the items clicked. 

Figure 6-17:  Panel window 

 

Figure 6-18:  PDU window 
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6.4.5 Input Board window 

The discrete input board status window shows the raw data from the Modbus registers. 

Figure 6-19:  Input Board status window 

 

6.4.6 Thermal windows 

The thermal settings for each Modbus register are shown in the Thermal Settings Window.  Settings 

include alarms, warnings and delay times.  These are shown PowerView chassis slot that holds a 

Thermocouple Input Board. 

Figure 6-20:  Thermal Settings window 
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The thermal readings for each Modbus register are shown in the Thermal Readings Window.  These are 

shown PowerView chassis slot that holds a Thermocouple Input Board. 

Figure 6-21:  Thermal Readings window 

 

 

6.5 Polling Menu 

This menu controls Modbus polling.  The Modbus port can be closed and reopened without exiting the 

program by clicking "Polling" on the menu bar and unticking the "Modbus Polling" menu item as shown 

below.  This is convenient to use when you want to temporarily communicate with the PowerView with 

another application.   

Figure 6-22:  Modbus Polling window 

 

 

6.6 Service Menu 

The Service menu contains features for configuring and calibrating your PowerView.  This menu is 

accessible only when logged in at Level 2.  See your ABB service representative for more information on 

calibration and configuration of your PowerView. 
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6.7 Window Menu 

This menu contains standard Windows commands for arranging windows in the configuration tool.   

Figure 6-23:  Window Menu 

 

Child windows can be automatically arranged inside of the main parent window by selecting "Cascade" or 

"Tile" in the menu under "Window" as shown below, or by simply pressing the F2 or F3 key, respectively.  

If "Tile" is selected when there are a lot of child windows open, some of them will usually go out of the 

viewing area and a vertical scrollbar will then appear.  You can then use this scrollbar (with the mouse) to 

view the child windows that are currently out of the viewing area.   

The scrollbars on the main parent window can also be operated by the navigation keys on the keyboard as 

follows.  First, press the F4 key (or select Window> 

Scroll Mode as shown below) to enter a special "Scroll Mode".  When in Scroll Mode, the Page Up, Page 

Down, and arrow keys will operate the scrollbars on the main parent window.  To exit Scroll Mode, press 

the Esc key, or click the mouse anywhere.   

Selecting "Normalize All Windows" in the menu below will cause any minimized child windows to re-open.   

Selecting "Close All Windows" will close all open child windows.   

  



64  94-1100-00002861 D0 EN│Cyberex® Power Distribution Unit 

— 

7 System maintenance 

Minimal periodic maintenance of the unit is required.  As with all electrical distribution components, this 

system should be regularly inspected for electrical connection integrity, signs of excessive temperature, 

accumulation of dirt, and proper system operation.  Follow all safety and maintenance procedures listed in 

your RPP or PDU manual. 

As with any electronic devices, critical circuits are subject to normal life cycle effects.  ABB offers various 

service plan levels to keep your equipment in peak operating condition as the unit ages. Contact ABB 

Service Sales at ric_servicesales@ us.abb.com   or go to https://new.abb.com/ups/service-ups-and-

power-conditioning to learn more. 

 

 

Warning  

 

WARNING 

− Only qualified service personnel should perform maintenance on the 

PowerView 

− Exercise extreme care to avoid equipment damage or injury to personnel.  

Follow all safety procedures listed in your RPP or PDU manual. 

− Lethal voltages exist inside the distribution product during normal 

operation. 

 

 

7.1 Software upgrades 

Power View software upgrades must be completed by certified ABB personnel, who have the proper 

system security access.  Please contact your ABB representative to upgrade the system software. 

7.2 Adding monitoring capabilities 

PowerView monitoring capabilities can be changed or upgraded by changing or adding ACBs.  These 

changes must be completed by certified ABB personnel.  Please contact your ABB representative to learn 

more. 

  

https://new.abb.com/ups/service-ups-and-power-conditioning
https://new.abb.com/ups/service-ups-and-power-conditioning
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8 Specifications 

8.1 Standards 

The PowerView is compliant with the applicable requirements of: 

− Recognized Component by ETL to Underwriters Laboratories (UL) 60950-1 Information Technology 

Equipment – Safety    

− Enclosure:  NEMA 1 

− Accuracy: ANSI/NEMA C12.1 – 2015 (at 60Hz) 

− Electromagnetic Compatibility (EMC): FCC compliant (part 15) 

8.2 Metering ranges and accuracy 

Metering measurements are completed through an ACB or PSB.  Temperature measurements are 

completed through a TIB. 

8.2.1 Metering ranges 

Table 8-1:  Meter ranges 
 

Parameter Branch Circuit Monitoring All other monitoring 

Full load rating 60A/branch (100A optional) Configurable 

Overload capacity 115% 115% 

System voltage rating 277/480V – 3 Φ 600V – 3 Φ 

Frequency (nominal) 50-60 Hz 50-60 Hz 

 

8.2.2 Measurement accuracy 

Table 8-2:  Measurement accuracy (60Hz) 

Parameter Branch Circuit Monitoring All other monitoring 

Current +/-1% from 1A to 70A/branch 
+/-1% from 10% of full load 

rating to full load rating 

Voltage +/-1% +/-1% 

Power factor +/-0.01 +/-0.01 

Power (KW) +/-1% from 1A to 70A/branch 
+/-1% from 10% of full load 

rating to full load rating 

Frequency +/-0.01Hz +/-0.01Hz 
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8.2.3 Thermal Measurement  

Table 8-3:  Temperature parameters 
 

Parameter Capability 

Measurement Accuracy +/-1%, +/-2° full scale 

Range at Rated Accuracy 0°C to 250°C 

Maximum Temperature 250°C 

Temperature Resolution 0.25 °C 

 

8.3 Communications 

The PowerView shall support the following communication options: 

− RS485 port with Modbus RTU protocol: 2-wire or 4-wire connection, up to 38400 baud 

− Modbus TCP/IP, ability to be pinged by up to 5 building monitoring systems BMS 

− USB for data downloads and service access 

 

8.4 Environmental characteristics 

The PowerView has the capability of withstanding any combinations of environmental conditions listed 

below without mechanical or electrical damage or degradation of operation. 

− Operating ambient temperature:  0 to 40° C 

− Non-operating and storage ambient temperature:  -40 to 60° C 

− Relative Humidity:  10% to 95% non-condensing 

− 1000m (3300ft) above sea level.  

− Non-operating altitude:  15,000m 

− Equipment is designated for indoor use in a clean (dust-free), temperature and humidity-controlled 

environment 
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8.5 Monitoring Capacity 

Monitoring capacity depends on your system’s exact combination of daughter cards.  Installed systems 

can be upgraded to maximum monitoring capacity with additional plug-in daughter cards.   

Power View capacity upgrades must be completed by certified ABB personnel.  Please contact your ABB 

representative to upgrade the system software or hardware. 

 

8.5.1 PDU Monitoring 

PDU measurement supports both Delta-Y and Y-Y transformers. 

1 PSB or 2 ACB’s are required to monitor voltage, current and power on the PDU transformer.  Up to 2 

sources can be measured with either configuration. 

PDU input current can be measured with either configuration, when connected to appropriate current 

transformers. 

8.5.2 Branch Circuit Monitoring (BCM) 

Number of panels per ACB:  1 

Number of branches per panel: 42 or 84  

Total number of branches:   252 (assumes 6 ACBs) 

Voltage sensing options: 

 Number of 3 Φ sources: 1 to 6 sources (1 source per ACB) 

8.5.3 Sub-feed Circuit Monitoring (SFCM) 

Sub-feeds are recommended to be monitored with an ACB. 

Number of sub-feeds per ACB 

 With neutral:   10 

 Without neutral:  13 

Total number of sub-feeds 

 With neutral:   60 (assumes 6 ACBs) 

 Without neutral:  67 (assumes 6 ACBs) 

Voltage sensing options: 

 Number of 3 Φ sources: 1 to 6 sources (1 source per ACB, 2 sources per PSB) 

8.5.4 Discrete Input Capacity 

PowerView has capacity for up to 150 input sensors, 25 per DIB, up to 6 DIB’s. 

8.5.5 Thermocouple Input Capacity 

PowerView has capacity for up to 90 thermal sensors, 15 per TIB, up to 6 TIB’s.   
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Note 
 
We reserve the right to make technical changes 
or modify the contents of this document 
without prior notice. With regard to purchase 
orders, the agreed particulars shall prevail. ABB 
does not accept any responsibility whatsoever 
for potential errors or possible lack of 
information in this document. 
 
We reserve all rights in this document and in 
the subject matter and illustrations contained 
therein. Any reproduction, disclosure to third 
parties or utilization of its contents   in whole or 
in parts – is forbidden without prior written 
consent of ABB. 
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